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Important

This equipment has been tested and found to comply with the limits for a Class B digital device
in accordance with the specifications in Part 15 of FCC rules. See instructions if interference to
radio or television reception is suspected.

Radio and television interference

The equipment described in this manual generates, uses, and can radiate radio-frequency
energy. If it is not installed and used properly—that is, in strict accordance with Apple’s
instructions—it may cause interference with radio and television reception.

This equipment has been tested and found to comply with the limits for a Class B digital device
in accordance with the specifications in Part 15 of FCC rules. These specifications are designed
to provide reasonable protection against such interference in a residential installation. However,
there is no guarantee that interference will not occur in a particular installation.

You can determine whether your computer system is causing interference by turning it off. If
the interference stops, it was probably caused by the computer or one of the peripheral devices.

If your computer system does cause interference to radio or television reception, try to correct
the interference by using one or more of the following measures:

» Turn the television or radio antenna until the interference stops.

s Move the computer to one side or the other of the television or radio.

= Move the computer farther away from the television or radio.

= Plug the computer into an outlet that is on a different circuit from the television or radio.

(That is, make certain the computer and the television or radio are on circuits controlled by
different circuit breakers or fuses.)

If necessary, consult an Apple-authorized service provider or Apple. See the service and support
information that came with your Apple product. Or, consult an experienced radio/television
technician for additional suggestions. You may find the following booklet helpful: Interference
Handbook (stock number 004-000-00493-1). This booklet, prepared by the Federal
Communications Commission, is available from the U.S. Government Printing Office,
Washington, DC 20402.
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Important

Changes or modifications to this product not authorized by Apple Computer, Inc., could void
the FCC Certification and negate your authority to operate the product.

This product was tested for FCC compliance under conditions that included the use of Apple
peripheral devices and Apple shielded cables and connectors between system components. It is
important that you use Apple peripheral devices and shielded cables and connectors between
system components to reduce the possibility of causing interference to radios, television sets,
and other electronic devices. You can obtain Apple peripheral devices and the proper shielded
cables and connectors through an Apple-authorized dealer. For non-Apple peripheral devices,
contact the manufacturer or dealer for assistance.

DOC Class B Compliance This digital apparatus does not exceed the Class B limits for radio
noise emissions from digital apparatus set out in the radio interference regulations of the
Canadian Department of Communications.

Observation des normes—Classe B Le présent appareil numérique n’émet pas de bruits
radioélectriques dépassant les limites applicables aux appareils numériques de la Classe B
prescrites dans les réglements sur le brouillage radioélectrique édictés par le Ministére des
Communications du Canada.

WARNING Making adjustments or performing procedures other than those specified in your
equipment’s manual may result in hazardous exposure.

WARNING Do not attempt to disassemble the cabinet containing the laser. The laser beam used in
this product is harmful to the eyes. The use of optical instruments, such as magnifying lenses,
with this product increases the potential hazard to your eyes. For your safety, have this
equipment serviced only by an Apple-authorized service provider.

This printer is a Class 1 laser product. It carries a Class 1 label underneath the printer and a
service warning label inside the printer.

DANGER - invisible laser radiation when open. AVOID DIRECT EXPOSURE TO BEAM.

A CAUTION - INVISIBLE LASER RADIATION WHEN OPEN. AVOID EXPOSURE TO BEAW
ATTENTION - RAYONNEMENT LASER INVISIBLE EN CAS D'OUVERTURE. EXPOSITION DANGEREUSE AU FAISCEAU.
VORSICHT - UNSICHTBARE LASERSTRAHLUNG, WENN ABDECKUNG GEOFFNET. NICHT DEM STRAHL AUSSETZEN.
ATTENZIONE - RADIAZIONE LASER INVISIBILE IN CASO DI APERTURA. EVITARE L'ESPOSIZIONE AL FASCIO. CLASS 1 LASER PRODUCT
PRECAUCION - RADIACION LASER INVISIBLE CUANDO SE ABRE. EVITAR EXPONERSE AL RAYO. LASER KLASSE 1
VARO! ~ AVATTAESSA OLET ALTTINA NAKYMATTOMALLE LASERSATEILYLLE. ALA KATSO SATEESEEN.
VARNING! - OSYNLIG LASERSTRALNING NAR DENNA DEL AR BPPNAD. BETRAKTA EJ STRALEN. APPAREIL A RAYONNEMENT
ADVARSELI- USYNLIG LASER STRALING, NAR DENNE ER ABEN. UNDGA BESTRALING. LASER DE CLASSE 1
ADVARSEL - USYNLIG LASERSTRALING NAR DEKSEL APNES. UNNGA EKSPONERING FOR STRALEN.

assaon  E M - TR - ONBTRFARL Y —(FRHENTVET, L— P~ REESTARNS ST LREL,

Service warning label Class 1 label



Setting Up Your Printer

This chapter introduces the Personal LaserWriter 320 printer and explains
how to set it up. After you follow the instructions in this chapter, you'll be

ready to print.

In

this chapter

Main features of the Personal LaserWriter 320

Important safety instructions

Choosing a location for the printer

Connecting the printer to your Macintosh

Installing the toner cartridge

Putting in paper

Plugging in and turning on the printer

Installing your printer software

Telling your Macintosh to use the Personal LaserWriter 320

Trying out the printer
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Main features of the Personal LaserWriter 320

Chapter 1

PostScript™, a technology that allows for precise printing of fonts and
pictures, is built in to the printer.

An energy conservation feature turns the printer on and off automatically.
The printer shuts off most of its functions when they aren’t in use and
“wakes up” automatically when you print a document.

Printed images can have more than 90 levels of gray.

A collection of 35 PostScript fonts built in to the printer provides a large
selection of typefaces for business, desktop publishing, and graphics needs.

FinePrint smooths lines and curves that would otherwise appear jagged.

PhotoGrade, available on printers with § MB of memory, prints lifelike
images by allowing you to control the number of levels of gray.

A LocalTalk port on the printer allows everyone on your AppleTalk
network to share the printer.



Important safety instructions

Always take the following precautions:

Keep the printer away from sources of liquids, such as wash basins,
bathtubs, shower stalls, and so on.

Protect the printer from dampness or wet weather, such as rain, snow, and
SO on.

Read all the installation instructions carefully before you plug the printer
into a wall socket.

Keep these instructions handy for reference by you and others.

Follow all instructions and warnings dealing with your system.

Don't use devices that produce open flames, such as Bunsen burners, near
the printer.

Don't use alcohol-based or ammonia-based cleaners on or around the
printer.

Clean the printer with only a damp cloth and, if necessary, a mild soap or
detergent. Be careful to avoid getting liquid in the printer or the power cord
receptacle.

Disconnect the power plug immediately if any of the following situations

occur:

the power cord or plug becomes frayed or otherwise damaged

you spill something into the case

the printer is exposed to rain or any other excess moisture

the printer has been dropped or the case has been otherwise damaged
you suspect that your printer needs service or repair

you want to clean the case (use only the recommended procedure
described in Chapter 3)

WARNING Electrical equipment may be hazardous if misused. Operation
of this product, or similar products, must always be supervised by an
adult. Do not allow children access to the interior of any electrical
product and do not permit them to handle any cables.

Setting Up Your Printer
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Choosing a location for the printer

Chapter 1

Choose a flat, stable surface with adequate room around the printer. The area
should be well ventilated and away from direct sunlight or sources of heat,
cold, or humidity. When choosing a location, also take into account the
information in the next section, “Ozone Emission.”

Allow 4 inches (10 cm) at the back of the printer for airflow.

Allow space for airflow
around the vent.

IMPORTANT Don't plug in the printer yet! Wait until you finish setting up the
printer (including connecting the cables and putting in the paper) as
described in this chapter. Unless everything is ready when you plug the
printer in, the printer may jam when it tries to print the startup page.

Ozone emission

Ozone gas is emitted by almost all laser printers and photocopiers. Because
ozone can be an irritant, various regulatory agencies have established limits
regarding the amount of ozone to which employees may be exposed.

The current OSHA permissible limit for ozone is 0.1 parts of ozone per
million parts of air (ppm). The Personal LaserWriter produces unmeasurable
quantities of ozone, far below the current limit specified by OSHA.

To minimize ozone exposure, install the LaserWriter in a well-ventilated area.
If there are other laser printers or photocopy machines in the same area,
additional air circulation may be required. Do not place the LaserWriter in a
small, enclosed space that lacks adequate ventilation. Position the printer so
that the fan exhaust does not blow directly into anyone’s face.



Connecting the printer to your Macintosh

You can connect the Personal LaserWriter 320 to your Macintosh directly, or
over an AppleTalk network, as explained in the next two sections.

Connecting directly to your Macintosh

If your Macintosh isn’t connected to a network, you can connect the printer
directly to your computer. (If your computer is connected to a network, skip
to the next section now.)

Note Even though the printer and the computer are connected by a simple
cable, technically this arrangement still counts as a network, albeit a very
small one.

1 Make sure you have a Peripheral-8 cable on hand.

2  Plug one end into the LocalTalk port on the printer and the other end into the printer port
on the back of the Macintosh.

No matter which Macintosh
> you have, this icon identifies
the printer port.

Press the cable firmly into
this notch to secure it.

3 Skip the next section and go to “Installing the Toner Cartridge” later in this chapter.

Setting Up Your Printer
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Connecting over an AppleTalk network

If your Macintosh is already connected to a network, connect the printer to
the network too. Every Macintosh on the network can print on the printer.

Note Everyone on the network who wishes to use the Personal LaserWriter
320 must install the printer software and choose the printer as described in
“Telling Your Macintosh to Use the Personal LaserWriter 320" later in this

chapter.

Before you begin 1If you already plugged in the printer, unplug it now.
Make sure you have a LocalTalk connector box and a LocalTalk cable.
Connect the cables as shown here:

Plug the connector box cable
into the printer's LocalTalk port.

" Press the cable firmly
into this notch to secure it.

To network

Use a LocalTalk cable to connect the printer's connector
box to a connector box anywhere on the network.



Installing the toner cartridge

Toner is the powdered ink that produces the image on the paper. Follow these
steps to install a toner cartridge in the printer for the first time.

1  Open the printer lid.

If you're installing a toner cartridge for the first time, remove the colored
plastic shipping inserts, as shown in the picture. If you're replacing a toner
cartridge, remove the old cartridge.

Press the two
plastic shipping
restraints to

remove them.

Press this button
to open the lid.

Setting Up Your Printer



2 Unpack the toner cartridge and gently rock it to distribute the toner inside.

Gently rock the toner cartridge.

Save the protective bag. If you move or transport your printer, you will need
to remove the cartridge and transport it separately in the bag.

Don’t expose the cartridge to direct sunlight. Don’t expose it to room light for
more than five minutes, or the life of the cartridge may be reduced.

3 Pull the tab to remove the tape.

Pull the tape in the directi
shown. Do not pull it to either

side or it may break.
Pull the tape

completely out.

WARNING Be sure to pull the tape in the direction shown. Don’t pull it
too quickly or at too sharp an angle; otherwise, the tape may break.

Chapter 1




4 Insert the cartridge into the printer.

Line up the markings on the sides of the cartridge with the arrows in the

printer.

Align
these arrows.

AN

W

R

AN

5  With both hands, press down gently on the cartridge to secure it in place.

6  Close the printer lid.

Setting Up Your Printer
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Putting in paper

Chapter 1

You can put up to 100 sheets of copier-weight bond paper into the paper
cassette supplied with your printer. You can use the following sizes: U.S.
Letter, A4, B5, U.S. Legal, or Executive. For advice on paper quality, see
Chapter 4, “Tips and Troubleshooting”

To load the paper cassette:

Pull the cassette out of the printer and place it on a flat surface.




2

Before loading the cassette for the first time, remove the orange cardboard and plastic
shipping inserts.

To remove the plastic insert,
turn the cassette over and
press both clips.

Adjust the cassette for your paper. Always load Letter or A4 paper into the cassette just
before you plug in the printer.

Slide this backstop toward
the center of the cassette.

Move the backstop until this
arrow points to LTR or A4.

Make sure the backstop is in one of the notches. If you set it between notches
you may cause a printing error.

Note You must put in Letter or A4 paper before you plug in the printer, so it
can print its startup page. You can switch to another paper size later.

Setting Up Your Printer 11



12

Chapter 1

4

5

Insert a stack of paper under the brackets. If you use 3-hole paper, line up the holes as
shown:

Insert letterhead paper face down with the top
of the page at this end of the cassette.

Push firmly to make sure
the cassette is in place.



Plugging in and turning on the printer

The Personal LaserWriter 320 printer has no on/off switch. As soon as it is
plugged in, the power is on and the printer is standing by, ready to print. To
save energy, the printer turns off most of its functions when they’re not being
used. As soon as it detects something to be printed, the printer “wakes up”
and goes to full power.

The Personal LaserWriter 320 is intended to be plugged in and on standby
continuously. There is no need to unplug it, except to maintain it or move it.
When it’s standing by, the printer consumes very little energy—Iless than 10
watts, about the same as a night-light.

Before you begin Make sure you have installed the paper and toner cartridge
and connected the printer to your Macintosh.

1 Attach the power cord to the printer as shown:

This light glows steadily while the printer is standing by~
It blinks while the printer is working. / O

Notch for power cord

IMPORTANT The only way to disconnect power completely is to unplug the
power cord. Make sure at least one end of the power cord is within easy reach
so that you can unplug the LaserWriter when you need to.

Setting Up Your Printer 13



2 Plug the other end of the power cord into the wall

WARNING The Personal LaserWriter 320 is equipped with a three-wire
grounding plug—a plug that has a third (grounding) pin. This plug will
fit only a grounded AC outlet. This is a safety feature. If you are unable
to insert the plug into the outlet, contact a licensed electrician to replace
the outlet with a properly grounded outlet. Do not defeat the purpose of
the grounding plug!

3  Wait for the startup page to print.

When you plug the power cord into an outlet, the green Ready/In Use light
comes on. After a few moments the light begins to blink, and a little while
later the startup page prints.

If you inserted A4 paper into the paper tray, an amber light may start to glow
on the printer after the startup page prints. To reset the light, remove and
replace the paper tray.

14 - Chapter 1



Installing your printer software

The Personal Laserwriter 320 comes with several disks that contain the
printer software and a program called the Installer that copies the software
onto your hard disk. Follow the steps in this section to install the software.

IMPORTANT If your Macintosh has System 6, installing the LaserWriter 8
driver places new versions of PrintMonitor and Backgrounder in your System
Folder. The new versions of PrintMonitor and Backgrounder may not work
with earlier versions of the LaserWriter driver using System 6. If you intend to
use an earlier version of the LaserWriter driver again, make copies of the
System 6 versions of PrintMonitor and Backgrounder before starting this
section and keep them for use with the older LaserWriter driver.

Before you begin Lock all four disks by turning each one over and sliding the
small, square plastic tab so you can see through the hole.

1 Insert the Personal LaserWriter 320 Installation disk into a floppy disk drive.
The disk’s icon appears on the desktop, as shown in the next step.

2 Double-click the disk icon to see what’s on the disk.

In=stall

Setting Up Your Printer . 15
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Double click the Installer icon to start the Installer program.

™
o

g

b
o
.,

™,
Installer

After a moment, the Installer displays information about what will be
installed.

IMPORTANT The Installer checks to make sure you have the correct system
software and enough Macintosh memory to use this printer. If not, it displays
a message telling you what you need. You won't be able to install the software
until you correct the problem. If it says you don’t have the correct system
software, you can purchase a new version from your Apple-authorized dealer.

After you read the information on the screen, click OK.

Click the Install button.

The Installer takes a few minutes to calculate what needs to be done and then
begins to copy files.

When the Personal LaserWriter 320 disk is ejected, follow the instructions on your
screen.

The Installer will eject disks and ask you to insert others. Keep following the
instructions on the screen until the installation is complete.

More information about the Installer program

The procedure described above copies all the software you need onto your
hard disk. In very rare circumstances, you may want to copy only a subset of
the software. In that case, click the Customize button in the Installer to see a
list of choices, then click a choice to see a description of it. To install
something in the list, click to select it, then click the Install button.



Telling your Macintosh to use the Personal LaserWriter 320

Before you use your Personal LaserWriter 320 for the first time, you must
select it in the Macintosh Chooser.

IMPORTANT If you have upgraded your printer so it has more than 2 MB of
memory, skip this section and turn to Appendix A, “Upgrading Your Printer’s
Memory,” instead. (The instructions there completely replace the instructions
in this section.) You can tell how much memory your printer has by looking at
the startup page you just printed.

Before you begin Make sure the printer is plugged in, your computer is turned
on, and the printer is connected to your Macintosh.

1 Open the Chooser by pulling down the Apple (#) menu and selecting Chooser.

About This Macintosh...

% Alarm Clock
Calculator
= Chooser

Control Panels

Setting Up Your Printer 17




2 Click items in the Chooser as follows:

First, click the LaserWriter 8 icon. (If you don't see it, click the scroll arrows.
There may be a number of other icons here.) After a moment, your printer's name
Iappears in the box to the right.

ED% Chooser
@ [ Select a PostScript Printer:
I Personal Laserwriter 320 |43
\ Second, click “Personal
LaserWriter 320.”

Third, click the Setup
/ ig| | button, which opens the

ackground Printing Setup dialog box.
® 0n O Off

[ cerup.)

@ Active

Applelalk (O Inactive

Ell

3 Inthe Setup dialog box, click Auto Setup.

Your Setup dialog box may have more buttons than this.

Current Printer Description File (PPD) Selected:
“Generic”

[ More Choices | [ Autosetup | [ cancel || ok |

The Macintosh displays messages on your screen while it selects the correct
Printer Description file.

4 Click OK to return to the Chooser.

A small icon now appears next to the name of your Personal LaserWriter 320
in the Chooser.

5 Close the Chooser by clicking its close box (in the top-left corner).

18 : Chapter 1




Trying out the printer

First, use this

pop-up menu to
indicate the size
of paper loaded
in the paper tray.

The best way to see if your printer is set up correctly is to try printing
something. You can print any document you want, or if you don’t know how
to print yet, follow these steps:

Before you begin Return to the Finder by quitting any programs you're
running.

Insert the Personal LaserWriter 320 Installation disk into a floppy disk drive.
The disk’s icon appears on the desktop, as shown in the next step.

Double-click the disk icon to see what’s on the disk.

Personal L% 320 Install

Double-click the Read Me icon to open the Read Me document.

Feadle

Pull down the File menu and choose the Page Setup command.
A dialog box opens.

Indicate what paper size you’re using.

@ |__Then, click OK.

Cancel
Reduce or
Enlarge: % —WI

Orientation: |J

You don’t need to choose the Page Setup command every time you print—you
need to use it only when you want to change the normal settings.

Setting Up Your Printer
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6 Pull down the File menu and choose the Print command.
A dialog box opens.
7  Click the Print button.

Printer: “Personal Laserlriter 320” [[m
CGDiES:E] Pages: ®@ All (O From: To: |:| [Cancel ]
.Paper Source . Destination.....

@ Printer
O File Help

® Al O First from:

Remaining fromd

For information about all the choices you can make in the Print dialog box,
see Chapter 2.

8  Pull down the File menu and choose Quit to leave the Read Me file.
9  Eject the disk by dragging its icon to the Trash.
10  Watch the printer to see what happens.

If everything is working correctly, the green printer light will begin to blink.
After a few moments, the printed page or pages will come out of the printer.
If there’s a problem, see Chapter 4 for suggestions.

20 - Chapter 1




Printing

This chapter explains how to print documents on a Personal LaserWriter 320
printer and how to use the LaserWriter Utility program. More printing
instructions can be found in the manuals for your application programs.

Before you use the printer, you should have set up the printer and installed
the software as described in Chapter 1.

In this chapter

» Choosing face-down or face-up delivery

» Defining the page setup

» Printing a document

» Printing complex documents

» Printing a document with FinePrint or PhotoGrade

= Printing paper or envelopes with the manual feed slot
» Printing on both sides of a page

» Using the LaserWriter Utility program

21
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Choosing face-down or face-up delivery

Chapter 2

You must choose where the paper comes out after it’s printed.

Face-down delivery You can choose face-down delivery only with copier-weight
bond paper. Face-down delivery has the advantage of keeping the paper
stacked in order. The face-down tray holds at least 25 sheets. To select face-
down delivery, set the paper delivery lever in the up position.

For face-down delivery, this lever must be up.
The paper comes out the top of the printer.

Face-up delivery Choose face-up delivery to print envelopes, transparencies,
labels, and thick papers. To select face-up delivery, make sure there is enough
space behind the printer for the paper to come out, and set the paper delivery
lever in the down position.

For face-up delivery, this lever must be down.
The paper comes out the back of the printer.



Defining the page setup

Almost every Macintosh program has a Page Setup command in the File

menu which you can use to set a variety of options, from changing the paper
size to applying visual effects. The most common options are already selected

for you, so you need to choose Page Setup only if you want to change them.

[ File I

Ngw

. Page Setup...
Print... ®P

To define the page setup for a particular document,
open the document then choose this command from
the File menu. A dialog box opens on your screen.

Quit #0

Your program m

ay offer options in addition to the ones shown here:

LaserlWriter 8 Page

Setup

Paper: Ccancel ]
Layout:[_1Up v]
Reduce or 5 [options |
Enlarge: f et )

Orientation: ||

Click the Help button for information about your choices. Click the Options
button to see these additional choices:

LaserlWriter 8 Options

Visual Effects: - -
[ Flip Horizontal  cancel |
[] Flip Vertical G i S
] tnvert Image Help

Printer Dptions:

[ Substitute Fonts

[ Smooth Text

(] Smooth Graphics

[ Precision Bitmap Alighment

[JLarger Print Area (Fewer Downloadable Fonts)
[J unlimited Downloadable Fonts in a Document

Printing

esccee

23
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Printing a document

Chapter 2

The Personal LaserWriter 320 prints your document using paper from the
paper cassette or from the manual feed slot—whichever option is selected
when you print. For instructions on selecting and using the manual feed
option, see “Printing Paper or Envelopes With the Manual Feed Slot,” later in
this chapter.

Before you begin Set the paper selector as explained in “Choosing Face-Down
or Face-Up Delivery,” earlier in this chapter.

Open the document you want to print or select its icon in the Macintosh Finder.
Choose Print from the File menu.

A dialog box opens with a number of printing options.

Set any options you like.

The most common options are already set for you. Click Help for a
description of the different parts of the dialog box. Click Options for more
choices.

Printer: “Personal LaserlWriter 320" m
Copies:‘i} Pages: ® Al From: To: [ Cancel ]

~Paper Source . .Destination....., i
@ AN OFirst from: [_Cassette __v] @ Printer Options |

femaining from ) File

Note You can find many other options in the Page Setup command, also
under the File menu. For details, see “Defining the Page Setup” earlier in this
chapter.

Click the Print button.

After a moment, the green light begins to blink. Then you hear the fan come
on. There is a brief wait before printing.



Printing complex documents

The more complex a document is, the more memory the Personal
LaserWriter 320 needs to print it. A complex document is one that uses many
different fonts that aren’t built into the printer. If you print a document too
complex for the amount of memory your printer has, you'll get a message
saying you have a PostScript error and the document won't print.

Sometimes you can solve the problem by turning on the Unlimited
Downloadable Fonts feature in the Page Setup Options dialog box. If that
doesn’t work, you can try using only built-in fonts. For a list of those fonts,
see Appendix B, “Built-in Fonts.” You can also try simplifying any pictures
you have in your document.

If you print complex documents often, you may want to purchase a memory
upgrade for the Personal LaserWriter 320. The printer comes with a minimum
of 2 MB of memory. You can upgrade to 4 MB or 8 MB. (You can tell how
much memory your printer has by printing the startup page. To print the
startup page, unplug the printer, wait a moment, then plug it in again.)

Printing a document with FinePrint or Photograde

Every Personal LaserWriter 320 printer includes FinePrint, a feature that
smoothes out jagged lines and curves.

If you install the 6 MB memory upgrade (giving the printer a total of 8 MB
of memory), you can also take advantage of the PhotoGrade feature to
increase the number of levels of gray in your images. More levels of gray
produce a more natural-looking, photographic quality. However, because
printing more levels of gray requires the printer to use larger, more noticeable
dots, the resolution (sharpness) of the image decreases. You can experiment
with various settings to find the balance between resolution and levels of gray
that suits your needs, as described in “Adjusting FinePrint and PhotoGrade”
(in “Using the LaserWriter Utility Program”) later in this chapter.

To turn FinePrint or PhotoGrade on and off, follow these steps:

1  Choose Print from the File menu.

The Print dialog box appears.

Printing



2 Select the options you want.
3  Click Options to open the Print Options dialog box.

4  If you want to turn on PhotoGrade, choose Color/Grayscale from the PhotoGrade pop-up
menu.

Print Options

Cover™ otk and White
SEVERTR= AN P int: . Color/Grayscale
use PhotoGrade, J
you must choose
this option. FinePrint(TM):[__Printer’s default v |

~fAfter Document [MJ
(Theip

!

PhotoGrade(TM):[_Printer’s default v |

5 Choose the settings you want from the FinePrint or the PhotoGrade pop-up menu.

Remember, you can use PhotoGrade only if your printer has 8 MB of
memory. Otherwise, the pop-up menu is dimmed.

Print Options

Cover Page: @ None () Before (O After Document (
Print: ) |@
PostScript™ Errors:[_No Special Reporting v | [He——lp]
Use these two o =k
pOp-Up menus o | FinePrint(TM):[_Printer’s default v |
turn the options PhotoGrade(TM): \/Ezinler’s default
on or off. | orr
What does “Printer’s default” mean? A default is the setting you get if you
don’t change anything. In this case, it can mean either on or off, depending on
how you set the default in the LaserWriter Utility program. See “Adjusting
FinePrint and PhotoGrade” (in “Using the LaserWriter Utility Program”) later
in this chapter to learn how to set the default.
6  Click OK.

7  Click Print.
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Printing paper or envelopes with the manual feed slot

If you want to use paper that is different from what’s already in the paper
cassette, you can use the manual feed slot to insert sheets one at a time as the
document is printed. You can also use the slot to print envelopes, heavier
paper, or paper of nonstandard sizes.

Note If you are printing envelopes, choose an envelope paper size from the
Page Setup dialog box. The manuals for the program from which you print
envelopes may offer advice on adjusting margins to line up the address on
different kinds of envelopes.

1 Open the document you want to print or select its icon in the Macintosh Finder.
2  Choose Print from the File menu.
The print dialog box opens.

3  Choose Manual Feed from the Paper Source pop-up menu.

Printer: “Personal LaserlWriter 320"
Eopies:@ Pages: @ All OFrom:|:| Tn:[:

Remaining from saiie : |__Help |

Choose Manual Feed from this pop-up menu.
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Insert a sheet of paper or envelope as shown. Be sure to keep the paper straight so it
feeds correctly.

Align along this edge.

Feed envelopes
flap side down.

Click Print.

The sheet or envelope you inserted is printed. If the document has additional
pages, a message on your screen will alert you each time a new sheet or
envelope is needed. To avoid paper jams, always wait for the prompt before
inserting a new sheet or envelope.




Printing on both sides of a page

Follow these steps to print a two-page document using both sides of the
paper.

1  Print the first side of the page using manual feed or the paper cassette.

2  Take out the printed sheet and turn it over so the printed side is up and the top of the
page is nearest the manual feed slot.

3 Print the second side using manual feed.

Always use manual feed for printing the second side. To avoid jams, don't load
already printed pages into the paper cassette.

Top of sheet
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Using the LaserWriter Utility program

Chapter 2

The LaserWriter Utility program allows you to control various aspects of the
Personal LaserWriter 320. You can use the program with other LaserWriter
printers as well, but depending on the capabilities of the printer model, it may
not perform the same functions. Before you can use the LaserWriter Utility
program, you must install it, as described in the next section.

Use the LaserWriter Utility with the Personal LaserWriter 320 to

name the printer

turn the startup page feature on and off

display a list of fonts built into the printer or downloaded to it
print a list of fonts built into the printer or downloaded to it
print samples of fonts built into the printer or downloaded to it
download fonts to the printer

send PostScript files to the printer

restart the printer

adjust FinePrint and PhotoGrade

set the print density (to lighten or darken printing)

see how many pages have been printed

set the default paper size

Before you can use the program for the first time, you must install it as
described in the next section.



Installing the LaserWriter Utility program

You must use the Installer program to install the LaserWriter Utility onto
your hard disk. The Installer places a copy of the LaserWriter Utility in your
System Folder.

Insert the Personal LaserWriter 320 Installation disk into a floppy disk drive.

The disk icon appears on the desktop, as shown in the next step.

Double-click the disk icon to see what’s on the disk.

FPer=onal L Install

Double-click the Installer icon to start the Installer program.

A
b= d

Installer

After a moment, the Installer displays information about what will be
installed.

After you read the information on the screen, click OK.

Click the Customize button.

| Customize |

Printing
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6

First, click
LaserWriter Utility.

i

Chapter 2

Ask to install the LaserWriter Utility program as shown here:

Click the items you want to select;
Shift-click to select multiple items.

System 7 Laserllriter 8.0 Software [ Install —}
System 6 LaserlWriter 8.0 Software

LaserWriter Utility

TrueType™ Init
= Mr. Big
Fonts
; fipet Hisk |
3 Laser¥riter Utility >
@ stee: Switch Disk |
Date: g —
Yersion: s —
This package contains the Laserwriter Utility application
Easy Install

Then, click this
button.

Watch the progress and follow any instructions on your screen.

When the installation is finished, click the Restart button.

The LaserWriter Utility program is now in your System Folder.



Naming the printer

You can give your Personal LaserWriter its own name. When it comes from
the factory, it's automatically named Personal LaserWriter 320.

Open the LaserWriter Utility program.
Choose the Name Printer command from the Utilities menu.
A dialog box appears with the selected printer’s current name.

Type the new name.

Note If you use a character that isn'’t a letter or number, like an asterisk, it
may look different when printed on the startup page.

Click Rename.

A message alerts you to select the printer’s new name in the Chooser. You
can't print or use other LaserWriter Utility functions until you do so. See
“Telling Your Macintosh to Use the Personal LaserWriter 320” in Chapter 1.

Click OK.

If other people use your printer, make sure you tell them the new name.

Turning the startup page feature on or off

The Personal LaserWriter 320 is usually set to print a page when you plug it
in. This startup page shows the printer’s name, the total number of pages
printed, the amount of memory, the number of built-in fonts, and the
communication settings. You can turn this feature off if you wish.

Open the LaserWriter Utility program.

Choose Set Startup Page from the Utilities menu.

A dialog box appears that allows you to turn the startup page on or off.
Click On or Off.

Click OK.

Printing
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Displaying a list of printer fonts

You can view a list of the fonts currently stored in the printer’s memory.
Open the LaserWriter Utility program.

Choose Display Available Fonts from the File menu.

Click the close box when you are finished viewing the list.

Printing a list of printer fonts

You can print a list of the fonts currently stored in the printer's memory.
Open the LaserWriter Utility program.

Choose Print Font Catalog from the File menu.

The Print dialog box is displayed.

Click Print.

Printing samples of printer fonts

You can print samples of the fonts currently stored in the printer’s memory.
Open the LaserWriter Utility program.

Choose Print Font Samples from the File menu.

The Print dialog box is displayed.

Click Print.




B LN

Downloading fonts to the printer

You can download additional fonts to the printer. You don't have to download
fonts to use them in printed documents, but doing so can make printing faster
than storing fonts only on your computer. All fonts you download to the
printer’s memory will be deleted when you turn off your printer.

Open the LaserWriter Utility program.

Choose Download Fonts from the File menu.

Click the Printer button to download fonts to the printer.
Click Add.

A dialog box appears.

Select the fonts you want to download.

Double-click the font name in the list, or select the name and click Add. If
you change your mind about any font you've added to the list, select the font
and click Remove.

Click Done when you have finished selecting fonts.
Click Download.

A dialog box informs you of progress and tells you when downloading is
completed.

Click OK.

Sending PostScript files to the printer

Many programs allow you to save an image as a Postscript or Encapsulated
PostScript (EPS) file. In addition, you can save any printable information as a
PostScript file by clicking the File button in the Print dialog box. You can also
obtain special PostScript programs to change internal LaserWriter settings.
You can send any PostScript file or program to the printer by following these
steps:

Open the LaserWriter Utility program.
Choose Download PostScript File from the Utilities menu.

A dialog box appears in which you can select the file.

Printing
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Click the file you wish to download.
Click Open.

A second dialog box appears, in which you indicate where on your disk to
save any PostScript response from the printer.

Select a folder in which to save the PostScript log file.
You can type a new name for the file if you wish.
Click OK.

The file is downloaded to the Personal LaserWriter 320, and any PostScript
response from the printer is saved on your disk.

Restarting the printer

You may need to restart the printer to clear its memory if you have problems
printing. Chapter 4, “Tips and Troubleshooting,” describes when this may be
necessary.

Open the LaserWriter Utility program.
Choose Restart Printer from the Utilities menu.

A dialog box appears asking you to confirm that you want to restart the
selected printer.

Click Restart.

It takes a few minutes for the printer to restart and be ready to print.

IMPORTANT Make sure no one is attempting to use the printer before you
restart it.




Adjusting FinePrint and PhotoGrade
1 Open the LaserWriter Utility program.
2  Choose Imaging Options from the Utilities menu.

3  Set the defaults for the FinePrint and PhotoGrade or adjust Photograde as you like.

Imaging Options
Printer Resolution:

Set the default for FinePrint™:

FinePrint. ——{ @ A Coff M

Photograde™:
Set the default for — _—E @ On (more levels of gray] (O Off

PhotoGrade. Frequency/Angle: To adjust
More Levels Greater PhotoGrade, slide
of Gray RESHUNIDD this lever to provide
. more grays or greatef
screen frequency (Ipi): 71 resolution.

Angle (°): 45
(use Default] [ cancel ] | ok |

To return to the original factory
settings, click this button.

Note You turn PhotoGrade and FinePrint on or off in the Print Options dialog
box (as explained in “Printing a Document With FinePrint or PhotoGrade”
earlier in this chapter). The on or off settings in the Imaging Options dialog
box shown here determine the default for the features—whether they should
normally be on or off. Even if its default is set to on, you can still turn
PhotoGrade or FinePrint off for a particular document in the Print Options
dialog box. Likewise, if its default is set to off, you can still turn PhotoGrade
or FinePrint on for a particular document in the Print Options dialog box.

4  When you're finished, click OK.

Printing




Setting the print density

You use the print density control to adjust the darkness of the printer’s output.
1 Open the LaserWriter Utility program.
2 Choose Print Density from the Utilities menu.

The Print Density dialog box appears.
3 Drag the slider right or left to increase or decrease the print density.

4  Click OK.

Seeing how many pages have been printed

The Personal LaserWriter 320 stores a running total of the number of pages it
has printed. You can display the current page count as follows:

1 Open the LaserWriter Utility program.
2  Choose Get Page Count from the Utilities menu.
A dialog box appears with the current page count of the selected printer.

3 Click OK when you are finished viewing.

Setting the default paper size

When you set up the Personal LaserWriter 320, its default paper size is U.S.
Letter. That means you must use the Page Setup command to indicate a
different size whenever you print using different sized paper. If you usually
use a different paper size, you can change the default by following these
steps:

1 Open the LaserWriter Utility program.
2  Choose Paper Handling from the Utilities menu.
Choose the default size from Paper Tray pop-up menu.

3  Click OK.
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Maintaining Your Printer

This chapter describes the few things you need to do to maintain your printer.

In this chapter
= Replacing the toner cartridge

s Cleaning the exterior
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Replacing the toner cartridge

Toner is the powdered ink that produces the image on the paper. When the
LaserWriter starts printing lighter than it usually does, it's probably time to
replace the toner cartridge, though you might want to try adjusting the print
density first (as explained in “Setting the Print Density” in “Using the
LaserWriter Utility Program” in Chapter 2).

To replace the toner cartridge, follow the instructions in “Installing the Toner
Cartridge” in Chapter 1.

Cleaning the exterior

Chapter 3

Before you clean the Laserwriter, unplug the power cord. Then wipe the
exterior with a clean, soft damp cloth. Use a mild soap or detergent if
necessary, but never ammonia-based or alcohol-based cleaners. Be careful not
to get any liquid in any of the receptacles.

WARNING Don’t use ammonia-based or alcohol-based cleaners on or
around the printer. Ammonia can react with the toner and alcohol can
hurt the plastic case.




Tips and Troubleshooting

This chapter provides solutions to printing problems you may encounter while
using your printer.

WARNING If you have a problem with your printer and nothing presented
in this chapter solves it, see the service and support information that
came with your printer or computer. If you attempt to repair the printer
yourself, any damage you may cause to the printer will not be covered
by the limited warranty.

In this chapter

Safety precautions
Checking the printer’s status lights
Solving some common problems

About paper

4



Safety precautions

Consider these rules of safety before you open the printer or attempt to
troubleshoot problems:

Don’t attempt to disassemble the printer.
Don’t use oil inside the printer.

Don’t use ammonia-based cleaners on or around the printer. They may
react with the toner.

Don’t use alcohol-based cleaners on or around the printer. They may react
with the plastic case.

Don't leave the access door open. Exposing the toner cartridge to light may
damage the cartridge.

Don’t open the drum-protection shutter on the toner cartridge.

Be sure the power cord is within easy reach, should you want to unplug the
printer at any time. Since the Personal LaserWriter 320 has no power
switch, unplugging it is the only way to turn it off.

Never try to defeat the interlock switches inside the printer.

IMPORTANT The fixing assembly in the printer operates at very high
temperatures. When you open the printer, don’t touch the fixing assembly.

I A |/ — | 1L A | | -

Fixing assembly
(This area gets very hot.)

Some odor from the heat of the printing process is normal.
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Checking the printer’s status lights
Always check the status lights first when a printing problem occurs. These
often tell you the cause of the problem.
Ready/In Use light T

Paper Out light ——[™ =
=

Paper Jam light

» The green Ready/In Use light glows steadily whenever the printer is plugged
in, and blinks when it is printing.

» The amber Paper Out light glows steadily when there is no paper in the
cassette or the paper cassette is removed, and blinks when the printer is
waiting for manual feed.

» The amber Paper Jam light glows steadily when any obstruction occurs in
the paper path.

If both the Paper Out and Paper Jam lights flash or glow at the same time, the
printer requires service.

Tips and Troubleshooting



4

Solving some common problems

If this icon is missing
from the Chooser,
you need to install the
printer software from
the disks that came
with your printer.

Chapter 4

The Chooser doesn’t show the LaserWriter 320 icon

E[[&——————————— Chooser

- O Select a PostScript Printer:
= KSs
" £} Personal Laseririter 320

% e
AppleShare W

&
Background Printing
® 0n O Off
@ Active
Gf | APPIETEIK 5 hactive

To install the printer software, follow the instructions in Chapter 1. Make sure
you select the printer in the Chooser.

The Macintosh can’t find the printer

If you have selected the printer icon in the Chooser but nothing prints or you
get a message that no printer has been found, one of the following may be the
cause:

» The printer has been unplugged. Make sure it is plugged securely into an
outlet (the green status light should be on).

= In the Chooser, you may have chosen the wrong printer. Select the correct
Chooser options as described in “Telling Your Macintosh to Use the
Personal LaserWriter 320” in Chapter 1.

= One of the connection cables is loose. Check to make sure that all the
cables between your computer and the printer are secure. See Chapter 1.

If you still can’t resolve the problem, the printer may not be functioning
properly. Contact an Apple-authorized service provider about repairs.




The pages print on the wrong Personal LaserWriter 320

If you have more than one Personal LaserWriter 320 connected to your
network, make sure you have the correct one selected in the Chooser (See
“Telling Your Macintosh to Use the Personal LaserWriter 320” in

Chapter 1)

If that doesn’t solve the problem, the two printers may have the same network
identification number—a problem caused by plugging in the printer before
connecting it to the network. To solve the problem, identify which printers are
being confused with each other, make sure both are connected to the network,
unplug each from the wall, wait a moment, and plug them in again. Then
select the printer you want as described in “Telling Your Macintosh to Use the
Personal LaserWriter 320” in Chapter 1.

The Larger Print Area option is dimmed in the Page Setup Options dialog box

If your Personal LaserWriter 320 has only 2 MB of memory, you cannot use
the Larger Print Area option.

Printing goes beyond the bottom of the page

You may have set up your document as a legal-size page in the Page Setup
dialog box and loaded letter-size pages in the printer. To correct the problem,
change the page setup or load different paper.

Printing takes a long time

Printing may be slow on pages containing complex graphics or pages printed
using landscape (horizontal) orientation.

The processing speed of your computer and the amount of memory it has
directly affect printing time. Using a faster computer or upgrading your
printer’s memory will speed up printing.

Text lines up in columns on the screen but not when it prints

You may have used spaces (rather than tabs) to line up the text. Because
printers interpret spaces differently than does the screen, the text may fail to
line up when you print it. Try replacing the spaces with tabs.

Tips and Troubleshooting
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The printer won’t print a particular page or document

If a document contains a page with a great number of different fonts or very
complex graphic images, the printer may be unable to print the page and you
will see this error message:

A PostScript error has occurred.
See PrintMonitor for details.

If you see this error, follow these steps:
Click OK to close the error dialog box.

Pull down the application menu on the right side of the menu bar and choose
PrintMonitor.

PrintMonitor opens and a dialog box asks if you want to cancel or try again.
Click Cancel.
Close PrintMonitor by choosing Close from the File menu.

Return to the document you're trying to print and try the following:
= Select Unlimited Downloadable Fonts in the Options area of Page Setup.

= Reduce the number of fonts you need to download by using only fonts
built into the printer. For a list of such fonts, see Appendix B, “Built-in
Fonts.”

» Simplify complex drawings.
» Do not select Use Larger Print Area in the Options area of Page Setup.

= Use a smaller paper size. You are most likely to experience this problem
when printing legal-size documents.

s Add more memory to your printer.




The page prints differently on different printers

Try the following:

s Make sure you have the same fonts and printer software on each computer

you print from.

s Don’t use “Larger Print Area” option in Page Setup. The large page sizes
are not standard from printer to printer.

= Use tabs and margins (rather than spaces) to line up your text.
Type looks jagged or some text changes to the Courier or Geneva font

The most likely cause of this problem is that you are using a bitmapped font
instead of an outline font.

TrueType and PostScript fonts are outline fonts. A character from an outline
font can be printed smoothly in any size you specify. Your Personal
LaserWriter 320 comes with a set of outline fonts.

Bitmapped fonts are fixed in shape and size. Your printer can produce smooth
bitmapped characters only in the sizes for which it has instructions (a map of

dots for each font size). If you use a bitmapped font in a size for which your
printer does not have instructions, your system tries to create the size you
want. The resulting characters can look jagged. Even a font that looks good
on your screen can look bad when printed.

The best solution to this problem is to switch to an outline font. All the fonts
shipped with this printer are outline fonts. (For a list of these fonts, see
Appendix B)) For more information about outline fonts, see the books that
came with your Macintosh.

When your computer runs low on memory, TrueType turns itself off and
some TrueType fonts may be displayed and printed in the Geneva font. If
you've installed bitmapped versions of your TrueType fonts, they will not
change to Geneva, but they will look very jagged when TrueType is turned
off.

Tips and Troubleshooting
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The printer prints on only part of the paper

Make sure you have selected the appropriate paper size in the Page Setup
dialog box.

Check the adjustment of the sliding backstop in the paper cassette to make
sure it is correct for your paper size. See “Putting in Paper” in Chapter 1.

Paper is jammed

To avoid paper jams, make sure that the paper size indicated in the Page Setup
dialog box matches the actual paper size, that the paper cassette is properly
loaded, that you use only recommended paper types (see “About Paper” later
in this chapter for advice on choosing paper), and if you are using manual
feed, that you wait for the prompt before inserting a new sheet. Also, before
plugging the printer in for the first time, make sure you have installed A4 or
Letter size paper. Paper jams are sometimes caused by moving or jarring the
printer.

If the Paper Jam light is on, follow these steps in order until the Paper Jam
light goes oft:

1 Remove the paper cassette.

Be sure the paper is loaded correctly in the paper cassette. The stack of paper
should fit under the corner brackets. With the paper cassette removed, look
inside the printer and remove any jammed sheets you see.

Replace the paper cassette.

48 . Chapter 4




2 Open the printer and remove the toner cartridge.

With the toner cartridge out of the way, remove any jammed sheets you see.
Pull the sheets straight out. Avoid pulling at an angle that might tear the
paper and leave scraps inside the printer.

Replace the toner cartridge when you're finished.
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3  Open the printer's back door as shown below. Press the paper release lever and pull the
jammed sheets out through the front.

This type of jam is often caused by an interruption in printing.

Press the
paper release lever.

4  If paper is wrapped around the roller, pull it down and out.

Unwanted lines or stripes appear

If white or dark lines appear on the page, remove the toner cartridge and rock
it to redistribute the toner. Be sure to hold the cartridge horizontally.
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Paper feeds improperly

If paper tears, gets skewed, or comes through the printer crumpled, it may not
be entering the printer properly.

Remove any jammed sheets from inside the printer. Remove the paper
cassette, turn the stack of paper over, and replace the cassette. (Most paper
has one side that prints better,) It may also help to fan the edge of the stack
with your thumb, in case some of the sheets are stuck together.

Make sure the stack of paper is loaded correctly into the paper cassette, and
fits under all the corner brackets.

Some papers cause jams because they are not intended for use with laser
printers. See “About Paper,” later in this chapter, for advice on choosing
papers.

Toner stains appear on printed pages

If the printed pages are not clean, there may be a buildup of toner on the
printing rollers. If stains appear on the backs of printed pages, you may have
printed an image that is larger than the paper, causing toner to be deposited in
the paper path.

To clean the rollers, print several blank pages until the stains disappear. (You
can use any word processing program to print blank pages. Just open a new
file and print it.)

The image is too light or too dark

If printing is too light or too dark, try the following:

= Take out the toner cartridge and rock it gently to distribute
toner. If this doesn’'t help, you may need to replace the cartridge. See
“Installing a Toner Cartridge” in Chapter 1 for instructions.

= Adjust the print density, as described in “Using the LaserWriter Utility
Program” in Chapter 2.

= Try using a fresh package of paper. If the problem occurs on paper other
than standard copier-weight bond, the toner may not adhere well to the
paper you are using. For advice on choosing paper for your laser printer,
see “About Paper,” next.

Tips and Troubleshooting 51




About paper

Many problems (such as toner smearing, paper curling, or improper paper
feeding) can be caused by the paper you are using. To assure good results, use
only paper, envelopes, and transparencies that are manufactured for use with
laser printers and photocopy machines.

Make sure any paper you use is free of rips, wrinkles, dust, and oil stains.
Paper with cutouts or perforations is not recommended.

Here is a list of papers to avoid:

» extremely slick or shiny paper

erasable typewriter paper

paper that is highly textured

coated paper

stapled paper
= envelopes that contain fasteners or snaps

= multipart forms

WARNING Do not use paper printed using low-temperature dyes or
thermography. Such materials can peel away from the paper or melt
inside the LaserWriter and cause damage. Colored paper can be used as
long as the color is added during the paper-making process, not after,
and the color can withstand the heat generated by the printer’s fixing
assembly (approximately 190° C or 374° F). Envelopes, transparencies,
and labels are acceptable as long as they contain no fasteners and can
withstand the heat generated by the fixing assembly.

The paper cassette can hold up to 100 sheets of U.S. Letter, A4, B5,
U.S. Legal, and Executive paper.
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Appendix A
Upgrading Your Printer’s Memory

Upgrading the memory in your Personal LaserWriter 320 has many benefits:

= It allows you to print documents that are more complex.
» It may speed up the printing of complex documents.

= It enables the use of PhotoGrade for more lifelike images (with a total of
8 MB of printer memory).

To purchase and install a memory upgrade for your printer, see your Apple-
authorized dealer.

WARNING To avoid damage to your printer, Apple Computer
recommends that only an authorized Apple-certified technician install
additional RAM. Consult the service and support information that came
with your Apple product for instructions on how to contact an Apple-
authorized service provider or Apple for assistance. If you attempt to
install additional RAM yourself, any damage you may cause to your
equipment will not be covered by the limited warranty on your printer.
See an Apple-authorized dealer or service provider for additional
information about this or any other warranty question.
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Once the upgrade is installed, you must tell your Macintosh that you have
increased the printer’s memory, as follows:

1 Open the Chooser by pulling down the Apple (#) menu and selecting Chooser.

About This Macintosh...

(& Alarm Clock
Calculator

> Chooser
Control Panels

2  Click items in the Chooser as follows:

First, click the LaserWriter 8 icon. (If you don't see it, click the scroll arrows.
There may be a number of other icons here.) After a moment, your printer's name
appears in the box to the right.

E0=—————— Chooser
|

<+ | Select a PostScript Printer:
Personal Laserwriter 320 |43

Second, click “Personal
LaserWriter 320.”

Third, click the Setup

/ || button, which opens the
W, i Background Printing Setup dialog box.
% Y., @ on O off
| ® Active
65 | AepleTalk O Inactive

3 Inthe Setup dialog box, click Auto Setup.

The Macintosh displays messages on your screen while it selects the correct
PostScript Printer Description (PPD) file for your model of LaserWriter.
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If the Setup dialog box has only four buttons, click More Choices to see the rest of the
buttons.

Click Configure to see the Installable Options dialog box.

In the Installable Options dialog box, indicate which upgrade you have installed.

Current Printer Description File (PPD) Selected:
Gy  “Laserlriter Personal 320"

Installable Options:

I TIE I - Standard 2 MB First, use this pop-up menu
Upgrade to 4 MB to indicate the total amount

pgradeto & b of memory in your printer.

(cancer ) [_ok_—J— Then, click OK to close
this dialog box.

Click OK to return to the Chooser.

Close the Chooser by clicking its close box (in the top-left corner).

Upgrading Your Printer’s Memory
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Appendix B
Built-in fonts

The Personal LaserWriter 320 comes with 35 fonts built in to the printer:

Avant Garde (plain, italic, bold, and bold-italic)
Bookman (plain, italic, bold, and bold-italic)
@ourder (plain, dtalie, beld, and beld-italic)
Helvetica® (plain, italic, bold, and bold-italic)

Helvetica Narrow (plain, italic, bold, and bold-italic)

New Century Schoolbook (plain, italic, bold, and bold-italic)
Palatino® (plain, italic, bold, and bold-italic)
ZyupoA (Symbol)

Times® (plain, italic, bold, and bold-italic)

Zapf Chancery

KB DM OS VA (Zapf Dingbats)
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Appendix C
Technical information

Specifications

Print quality

s PostScript, 300 dots per inch for text and graphics

= Available: Apple’s FinePrint (standard) and PhotoGrade (with memory
upgrade)

Printer memory

= Two megabytes (MB) of random-access memory (RAM)

s Can be upgraded to 4 MB or 8§ MB

Printer fonts

= 35 fonts, listed in Appendix B, are built in. The Personal LaserWriter 320
can support additional fonts from Apple and from other suppliers.

Speed

= Four pages per minute maximum. Actual speed depends on the images
printed and the computer used.

Interface

= LocalTalk port for connection to an AppleTalk network
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Life expectancy

= Minimum life expectancy is 150,000 pages, with no monthly page limit.

Paper feed

= Automatic feed from paper cassette; manual feed for envelopes or single
sheets

Energy Star

» The Personal LaserWriter 320 is EPA-Energy-Star—compliant.

Printing materials

Apple recommends 20-pound photocopy bond (75 grams/meter?). You can use
16-pound (64 g/m?) to 28-pound (105 g/m?) paper with manual feed; the
paper cassette accepts 16-pound (64 g/m?) to 24-pound (90 g/m?) paper.
Accepts most letterhead and colored stock, and medium-weight laser printer
transparencies. Print labels using manual feed. Use envelopes recommended
for laser printers. Print envelopes, transparencies, and other special media
using manual feed and face-up delivery.

Paper sizes and capacity

The paper cassette can hold up to 100 sheets of U.S. Letter, U.S. Legal, A4,
B5, and Executive paper sizes.

Imageable area

Measured in millimeters (mm) and inches (in.):

= Maximum printable line: 208.534 mm (821 in.)
s Minimum top margin: 2.794 mm (0.1 in.)

s Minimum bottom margin: 5080 mm (0.20 in.)
» Minimum left margin: 3302 mm (0.13 in.)

= Minimum right margin: 4064 mm (0.16 in.)

Actual imageable area may vary depending on the application program.



Dimensions

Measured in centimeters (cm) and inches (in.):

= Height: 16.1 cm (6.3 in.)

s Width: 38.5 cm (152 in.)

s Depth: 379 cm (149 in)

Weight

= 7 kilograms (154 pounds) not including cartridge

Operating environment
Temperature
s 50° to 90.5° Fahrenheit (10° to 32.5° Celsius)
Humidity
= 20 to 80 percent, noncondensing

Toner cartridge storage environment
s 32° to 95° Fahrenheit (0° to 35° Celsius)

Input electrical requirements

U.S./Japan

s 100-120 volts HO percent
50-60 hertz 12 hertz

Europe/Australia

= 220-240 volts 0 percent
50 hertz 12 hertz
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Power consumption

Ozone emission

Operating
= 180 watts average at 115 volts or 220 volts

Standby

m less than 10 watts

Maximum input current
= 36 amperes at 120 volts
= 1.8 amperes at 220 volts

= Less than 005 parts per million maximum, measured in accordance with
European Computer Manufacturers Association (ECMA 129) or
Underwriters Laboratories (UL 114) standards for ozone density
measurement

Laser Specifications

Appendix C

= Type: Anode Common Type
» Wavelength: 775-795 nanometers

» Output power: 5 milliwatts



Index

A

A4 paper, for startup page 11, 14

Apple Peripheral-8 cable 5

AppleTalk network, connecting printer
on 6

Backgrounder, System 6 and 15
bitmapped font, outline font vs. 47
both sides of page, printing on 30
bottom of page, printing past 45
built-in fonts, listed 57

C

cassette, loading with paper 10-12
Chooser
LaserWriter 320 icon missing from
44
selecting printer in 17-18
cleaning the printer 3, 40
cleaning printing rollers 51

colored paper 52, 60
columns not lined up 45
complex document

printing 25

unable to print message 46
connecting the printer

on an AppleTalk network 6

directly to a Macintosh 5
copier-weight bond paper, face-down

delivery for 22

Courier font, problems with 47

D

defaults, defined 26
dimensions of printer 61
disconnecting the printer 13
disk with printer software 15, 31
documents

complex 25

printing 24-26

printing with FinePrint or

Photograde 25-26

downloading fonts to printer 35
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Index

E

Ecapsulated PostScript (EPS) files,
sending to printer 35-36
electrical consumption 62
electrical requirements 61
energy conservation feature 2, 13
Energy Star compliance 60
envelopes
acceptable types of 52
face-up delivery for 22
printing with manual feed 27-28
environmental requirements 61
EPA compliance 60

F

face-down or face-up delivery 22
File menu
Page Setup command 23
Print command 20, 24
FinePrint feature 2, 25
adjusting 37
printing documents with 25-26
turning on or off 25-26, 37
fixing assembly, caution about 42
fonts
additional, support for 59
built-in, listed 57
complex documents and 25
displaying list of 34
downloading to printer 35
PostScript capabilities 2
printing list of 34

G

Geneva font, jagged type or text changes
to 47
grayscale images 2
PhotoGrade feature and 25
grounding plug 14

H

heavy paper, printing with manual feed
27-28

icons, printer port 5

imageable area 60

Imaging Options dialog box 37

Installer 15, 16

installing LaserWriter Utility program
31-33

installing printer 1-20

J, K

jagged type 47

L

labels, face-up delivery for 22

Larger Print Area option, dimmed 45

laser specifications 62

LaserWriter 8 icon, placing in Chooser
18



LaserWriter 320, printing on wrong
printer 45
LaserWriter 320 icon, missing from
Chooser 44
LaserWriter Ultility program 30-33
installing 31-33
LaserWriter 8 driver, System 6 and 15
letterhead paper 60
letter-size paper, for startup page 11
life expectancy of printer 60
lights on printer 43
lines or stripes on page 50
loading paper 10-12
paper feed problems and 51
LocalTalk cable 6
LocalTalk connector box 6
LocalTalk port 2
connecting Macintosh to 5
location for printer 4

M

Macintosh Chooser. See Chooser
Macintosh computer, connecting to 5
maintenance
cleaning the exterior 40
cleaning printing rollers 51
replacing toner cartridge 7-9, 40
safety precautions 3
manual feed printing 27-28
memory
clearing by restarting printer 36
complex document printing and 25
displaying or printing fonts from 34
Larger Print Area option and 45
PhotoGrade feature and 25
specifications 59
TrueType fonts and 47
upgrading 25, 53-55
multiple fonts, unable to print message
46

N

naming the printer 33
network
interface 59
printing differently on two printers
47
printing on wrong printer 45

0

operating environment 61
outline fonts, bitmapped font vs. 47
ozone emissions 62

printer location and 4

PQ

page count, displaying 38
page setup
defining 23
for changing settings 19
Page Setup Options dialog box,
Unlimited Downloadable Fonts
feature 25
paper
acceptable types of 10, 52, 60
face-down or face-up delivery of 22
jammed 48-50, 51
light or dark printing and 51
printing past bottom of 45
recommended types of 60
selecting size of 19
setting default size for 38
startup requirements 11
unacceptable types of 52

Index
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Index

paper cassette
capacity of 60
loading 10-12
paper delivery lever 22
Paper Jam light 43
paper jams 48-50, 51
Paper Out light 43
paper size 60
printing on only part of page and 48
printing past bottom of page and 45
setting default 38
startup page 11
Paper Source pop-up menu 27
Peripheral-8 cable 5
Personal LaserWriter 320 Installation
disk 15-16
PhotoGrade feature 2
adjusting 37
printing with 25-26
turning on or off 25-26
turning or or off 37
plugging in the printer 13-14
PostScript capabilities 2
PostScript error, complex document and
25, 46
PostScript files
saving as 35
sending to printer 35-36
PostScript” fonts, as outline fonts 47
power consumption 62

Print command (File menu) 20, 24
print density, setting 38
print quality specifications 59
printer

naming 33

sending PostScript files to 35-36
printer fonts. See fonts
printer not found message 44
printer port icon 5
printer software, installing 15-16
Printer’s default, defined 26
printing 21-38

adjusting darkness of 51

both sides of page 29

documents 24-26

envelopes 27-28

face-down or face-up delivery 22

with FinePrint or PhotoGrade

25-26

manual feed 27-28

page setup for 23

samples of 34

speed of 59

startup page 11, 14

testing 19-20

too slowly 45
PrintMonitor, System 6 and 15
problems. See troubleshooting



R

radio interference v

Read Me file, printing 19-20
Ready/In Use light 14, 43

renaming the printer 33

resolution, PhotoGrade feature and 25
restarting the printer 36

S

safety precautions vi, 3, 4
grounding plug 14
in troubleshooting 42

sample fonts, printing 34

setup 1-20
connecting printer to a Macintosh 5
connecting printer to a network 6
installing printer software 15-16
installing toner cartridge 7-9
LaserWriter Utility program 31-33
location options 4
paper loading 10-12
plugging in printer 13-14
safety precautions 3, 4
selecting printer in Chooser 17-18
trying out printer 19-20

slow printing 45

soft fonts, downloading 35

software, installing 15-16
specifications 59-62
speed of printing 59
standby status 2, 13
startup page
memory shown on 25
paper size for 11
printing 14
turning on or off 33
status lights, checking 43
stripes on page 50
System 6, printer software and 15

system software, printer software and 15,

16

technical information 59-62

television interference v

thick papers, face-up delivery for 22

3-hole paper, loading 12

3-wire grounding plug 14

toner cartridge, installing or replacing
7-9, 40

toner stains on printed pages 51

total number of pages, displaying 38

transparencies, face-up delivery for 22

Index
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Index

troubleshooting 41

columns not lining up 45

Courier or Geneva font problems 47

image too light or dark 51

jagged type 47

Larger Print Area option dimmed
45

LaserWriter 320 icon not in Chooser
44

lines or stripes on page 50

paper feed problems 51

paper jams 48-50, 51

printer won’t print particular page or
document 46

printing differently on two printers
47

printing on only part of paper 48

printing past bottom of page 45

printing on wrong LaserWriter 320
45

slow printing 45

status lights 43

toner stains on printed pages 51

TrueType fonts, as outline fonts 47
trying out the printer 19-20
turning on the printer 13-14

u\v

Unlimited Downloadable Fonts feature,
complex documents and 25

upgrading memory 25

utility program. See LaserWriter Utility
program

WXYZ

“waking up” to full power 13
warranty
caution about 41
memory upgrade and 53
weight of printer 61



The Apple Publishing System

This Apple manual was written, edited, and produced on a desktop publishing system using
Apple Macintosh computers and QuarkXPress. Technical illustrations were drawn in Adobe”
Illustrator; screen shots were created and modified with system software, Exposure Pro, Aldus
SuperPaint, and Adobe Photoshop. Proof pages were created on Apple LaserWriter printers and
on QMS and Tektronix color printers. Final pages were output directly to separated film on a
PostScript-driven imagesetter.

Text type is Times, display type is Helvetica Narrow, and cover type is Apple Garamond,
Apple’s corporate font. Ornaments are custom symbols designed for Apple Computer. Some
elements, such as computer voice, are set in Apple Courier, a fixed-width font.

PostScript, the LaserWriter page-description language, was developed by Adobe Systems
Incorporated.
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